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Executive summary 

This white paper provides instructions for installing the Microsoft® Windows® 7 Professional, Microsoft 

Windows XP Professional and Windows Vista® Business operating systems (OSs) along with 

applicable HP drivers and applications on select HP EliteBook and HP ProBook Notebook PC models. 

Instructions are also provided for creating a common image for 2011 HP Business Notebook PCs. 

Target audience: This white paper is intended for IT staff. 

System requirements and prerequisites 

Information regarding minimum hardware requirements for the installation of Windows is available at 

http://www.microsoft.com. 

Supported models 

 HP EliteBook 2560p Notebook PC 

 HP EliteBook 2760p Notebook PC 

 HP EliteBook 8460p Notebook PC 

 HP EliteBook 8460w Notebook PC 

 HP EliteBook 8560p Notebook PC 

 HP EliteBook 8560w Notebook PC 

 HP EliteBook 8760w Notebook PC 

 HP ProBook 6360b Notebook PC 

 HP ProBook 6460b Notebook PC 

 HP ProBook 6560b Notebook PC 

 HP ProBook 5330m Notebook PC 

WARNING 

Before proceeding with the installation of Windows, you should back 

up all personal data, such as files and images. If it is not backed up, 

your personal data will be lost.  

The following items are needed to install Windows: 

 A supported HP business notebook PC model 

 Windows OS recovery media provided by HP 

– Media from an alternate source may require a product ID (PID)1 

 Access to Drivers/OS enhancements provided by HP 

– HP SoftPaq Download Manager (www.hp.com/go/sdm) 

– High speed Internet access (www.hp.com) 

– HP Driver Recovery DVD (DRDVD) 

                                                
1 Typically provided on the product’s Certificate of Authenticity 

http://www.microsoft.com/
www.hp.com/go/sdm
www.hp.com
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IMPORTANT 

Make sure you have the latest compatible versions of drivers and 

enhancements (Table 1). In addition, you must have a Microsoft 

operating system license for each system on which you install 

Windows XP Professional, Vista Business or Windows 7 

Professional. A Vista Business license allows you to use either XP 

Professional or Vista Business. The Windows 7 Professional license 

allows you to use Windows 7 Professional, Windows XP Professional 

or Windows Vista Business. 

Installing the OS, drivers, and enhancements 

This section provides guidelines for users performing a clean installation of Windows on a supported 

HP business notebook PC. 

For more information on installing Windows, refer to the Microsoft website at 

http://windows.microsoft.com/help. 

IMPORTANT 

Follow the installation instructions in the order provided. Failure to 

complete these steps in the proper order can result in an unsuccessful 

or unstable installation. These instructions are independent of the 

operating system currently installed on the notebook PC. 

1. Depending on the particular Internet connection(s) being used, download the driver(s) for the 

network interface card and/or wireless LAN adapter driver. Save to a USB storage device or 

optical media. 

– Contact your network administrator to properly set up the networking components of Windows. 

2. Change the boot order in F10 Setup so the optical drive is the first boot device. 

3. Boot with the Windows OS recovery disk provided by HP; follow the on-screen instructions for 

installation. 

– OS recovery media from HP does not require a product ID or key for installation on a supported HP 

business notebook PC. 

– HP recommends that you retain the HP_TOOLS partition to provide support for HP QuickLook, the 

F10 Setup graphical user interface, and HP diagnostics. For more information, refer to the white 

paper, “HP Business Notebook Computer EFI Guidelines.” 

– Older Windows XP OS media does not include serial ATA (SATA) drivers. For more information on 

loading SATA drivers, refer to the white paper, “Modifying a Windows XP installation to support 

SATA Native Mode on HP Business Notebooks.” 

– If using Advanced format hard drives (4K sector drives), please refer to the HP white paper 

“Preparing Advanced Format hard drives for Microsoft Windows installations on HP Business 

Notebook PCs and desktop PCs.” 

4. Install the appropriate communications driver from either the Driver Recovery DVD or USB storage 

device (Step 1 above) and configure your Internet connection. 

– For Windows XP, install the Microsoft Universal Audio Architecture (UAA) Bus Driver and Essential 

System Updates, then reboot prior to installing the audio and modem drivers. The audio driver may 

http://windows.microsoft.com/help
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require manual installation. (NOTE: The Universal Audio Architecture (UAA) Bus driver is integrated 

into Service Pack (SP) 3 and does not need to be installed separately). 

5. Install the desired patches from www.microsoft.com/windowsupdate or contact your network 

administrator for additional updates. Reboot the system after these patches have been installed. 

– For Windows XP, you must install Microsoft DirectX 9 and possibly Microsoft .NET Framework. 

For more information on .NET dependencies, refer to Table 1 below. 

6. Install the drivers and enhancements listed in Table 1 using HP SoftPaq Download Manager 

(available from www.hp.com/go/sdm); alternatively, you can download individual SoftPaqs from 

the HP website.  

For more information, refer to 

http://www.microsoft.com/windowsupdate
http://www.hp.com/go/sdm
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Appendix A: Using HP SoftPaq Download Manager. 

IMPORTANT 

To prevent possible data loss, HP recommends you adjust your 

power management settings prior to using the notebook. 

Drivers and enhancements 

Table 1 lists minimum recommended drivers and enhancements for Windows 7 Professional, Windows 

XP Professional and Vista Business.  The table also includes dependencies on .NET Framework (if 

applicable).  

Table 1. Minimum recommended software versions 

Name Version XP Vista Win 7 Priority 
.NET 

Required 

Driver – Audio 

IDT HD Audio Driver 6.10.6328.0 X X X 
Required 3.0 

Driver – Chipset 

Intel® Chipset Installation Utility 9.2.0.1021 X X X 
Required N/A 

Intel Management Engine Components 

Driver 
7.1.2.1041 X X X 

Required 
3.5 SP1 or 

greater 

Renesas USB 3.0 Driver 2.0.32.0 X X X 
Required N/A 

Driver - Graphics 

AMD Video Driver and Control Panel for 

Windows 7/Vista 

8.821.1.1-

110206A-

113218C 

 X X 
Required 3.5 SP1 

AMD Video Driver and Control Panel for 

Windows XP 

8.821.1.1-

110307A-

115133C 

X   
Required 3.5 SP1 

Intel HD Graphics with Turbo Boost 

Technology 

8.15.10.234

2 
 X X 

Required 3.0 

Intel Video Driver and Control Panel for 

Windows XP 

6.14.10.533

7 
X   

Required 3.0 

NVIDIA Workstation Graphics Driver for 

Windows 7 
267.96   X 

Required N/A 

NVIDIA Workstation Graphics Driver for 

Vista 
268.09  X  

Required N/A 

NVIDIA Workstation Graphics Driver for 

Windows XP 
267.96 X   

Required N/A 

Driver – Keyboard/Mouse/Input 

HP Hotkey Support 4.0.15.1 X X X 
Recommended 

3.5 SP1 or 

greater 
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Name Version XP Vista Win 7 Priority 
.NET 

Required 

HP Universal Camera Driver 
CP5850060

0_CL33412 
X X X 

Required N/A 

Synaptics Touchpad Driver 15.2.16.5 X X X 
Required N/A 

Validity Fingerprint Driver 4.3.126.0 X X X 
Required N/A 

Driver – Modem 

LSI HDA Modem Driver for Windows 2.2.100.0 X X X 
Required N/A 

Driver - Network 

Atheros 2011 Wireless LAN Driver 9.20 X X X 
Required N/A 

Broadcom 2070 Bluetooth for Windows 

7/Vista 
6.3 X X X 

Required 
3.0 or 

greater 

Broadcom 2070 Bluetooth for Windows 

XP 
5.6 X   

Required 
3.0 or 

greater 

Broadcom WLAN Driver and Utility 

Package 

5.60.401.25 

 
X X X 

Required N/A 

Ericsson Mobile Broadband Drivers 6.3.5.3 X X X 
Required N/A 

Intel 82579LM and 82579V Gigabit 

Ethernet Driver for Microsoft Windows 
11.8.81.0 X X X 

Required N/A 

Intel Wireless Drivers 14.0 X X X 
Required N/A 

Intel PROSet Extensions 14.0 X X X 
Optional N/A 

Sierra Wireless Driver Package for HP 

un2430 Mobile Broadband Module 
1.0.1.0 X X X 

Required N/A 

Driver – Storage 

Alcor Micro Smart Card Reader Driver 1.7.16.0 X X X 
Required N/A 

Intel Rapid Storage Technology Driver 10.1.2.1004 X X X 
Required 

3.5 SP1 or 

greater 

JMicron Media Card Reader Driver 1.0.58.0 X X X 
Required N/A 

Software - OS Enhancements/QFE’s 

Essential System Updates for Microsoft 

Windows 7 
1.1   X 

Required N/A 

Essential System Updates for Microsoft 

Vista SP2 
1.1  X  

Required N/A 

Essential System Updates for Microsoft 

Windows XP 
4.1 X   

Required N/A 

Software – Security 
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Name Version XP Vista Win 7 Priority 
.NET 

Required 

Embedded Security for HP ProtectTools 
6.0.100.257

2 
X X X 

Recommended 
N/A 

Privacy Manager for HP ProtectTools 
6.0.0.831 

 
X X X 

Recommended 3.5 SP1 

Software - Solutions 

HP 3D DriveGuard 4.1.2.1  X X 
Required N/A 

HP 3D DriveGuard for XP 1.20.3.1 X   
Required N/A 

HP Software Framework 4.0.90.1 X X X 
Required 

3.5 SP1 or 

greater 

Software – System Management 

System Default Settings for Windows 7 2.1   X 
Recommended N/A 

System Default Settings for Microsoft Vista 3.1  X  
Recommended N/A 

System Default Settings for Windows XP 6.0.4.2 X   
Recommended N/A 

Priority Key 

Required Mandatory for optimal hardware support 

Recommended HP recommends installing for optimal system performance 

Optional Value-add software for desired solution 

 

NOTE 

Some deliverables may have direct dependencies on other 

deliverables that may require .NET. 

Building a common image 

Instructions are provided for building Windows XP Professional and Windows Vista Business images. 

Windows XP Professional 

1. Install Windows XP Professional on a supported platform. 

2. Install the following and then reboot the system: 

– Essential System Updates for Windows XP 

– System Default Settings 

– Microsoft Universal Audio Architecture (UAA) High Definition Audio class driver (not required for 

XP SP3) 
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– Microsoft .NET (refer to Table 1 for .NET version requirements) 

3. Copy the i386 folder from the Windows XP installation DVD to the root of %SystemDrive%. 

4. Extract deploy.cab from the SUPPORT\TOOLS\ folder of the install DVD to the 

%SystemDrive%\sysprep folder. 

5. Copy all device drivers to a common folder location (i.e. %SystemDrive%\DRV). 

6. Run setupmgr.exe from the %SystemDrive%\sysprep folder to create a sysprep.inf file. 

7. As shown in Figure 1, make the following changes to the sysprep.inf file.  

– In the [Unattended] section –  

Change InstallFilesPath to %SystemDrive%\i386. 

The OemPnPDriversPath should include paths for all .inf installed drivers. 

– In the [SetupMgr] section –  

Change DistFolder to %SystemDrive%\i386  

NOTE 

Figure 1 does not show the complete sysprep.inf file. 

 
Figure 1. Updating the sysprep.inf  file  

 

 

8. Run the following command: 

  sysprep –mini –shutdown –reseal  

9. After shutting down the system, use hard-drive duplication software to deploy the common image. 

Windows Vista Business / Windows 7 Professional 

1. Install Windows Vista Business on a supported platform. 

2. Install the following and then reboot the system: 

– Essential System Updates for Windows Vista SP2 

– Vista Default Settings 

3. Copy all device drivers to the %SystemDrive%\DRV folder. 

4. Run Windows System Image Manager to create the sysprep.xml file.  

5. As shown in Figure 2, make the following changes to the sysprep.xml file:  
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– In the Microsoft-Windows-PnpCustomizationsNonWinPE component – 

Set the PnP driver search path. 

– In the Microsoft-Windows-Deployment component –  

Following the pass=”auditUser” phase, set Reseal in OOBE mode. 

NOTE 

Figure 2 does not show the complete sysprep.xml file. 

 
Figure 2. Example of sysprep.xml file 

 

 

6. Copy sysprep.xml to % SystemDrive%\Windows\System32\Sysprep. 

7. Run the following command: 

  sysprep /generalize /audit /shutdown /unattend:sysprep.xml 

8. After shutting down the system, use hard-drive duplication software to deploy the common image. 
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Appendix A: Using HP SoftPaq Download Manager 

Using HP SoftPaq Download Manager to update the current platform 

1. Boot the Windows OS. 

2. Open Microsoft Internet Explorer. 

3. Download and install HP SoftPaq Download Manager from www.hp.com/go/sdm. 

4. Launch SoftPaq Download Manager. 

5. When prompted, select Show software for this model only (Figure A-1).  

NOTE 

Use the Check software updates for this model option to 

automatically install the updates on the current system or to 

download SoftPaqs to install on systems similar to the current 

platform. 

 
Figure A-1. SoftPaq Download Manager menu  

 

 

6. The current platform will automatically be displayed and selected in the Product Catalog window. 

7. Select the desired SoftPaqs from the Available SoftPaqs list (Figure A-2). 

 

http://www.hp.com/go/sdm
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Figure A-2. Available SoftPaqs list  

 

 

8. After selecting the desired SoftPaqs, the following options are available in the Downloaded SoftPaqs 

window: Download Only, Download and Unpack or Download and Install (Figure A-3). 

 
Figure A-3. Downloaded SoftPaqs window  

 

 

 Download Only – this option will download all selected SoftPaqs to “C:\ProgramData\HP\HP 

SoftPaq Download Manger\SWDownload”. 

 Download and Unpack – this option will download all selected SoftPaqs to “C:\ProgramData\HP\HP 

SoftPaq Download Manger\SWDownload” and unpack each individual SoftPaq in a unique folder 

based on SP#: (i.e. \SPxxxxx).   

 Download and Install – this option will download all selected SoftPaqs to “C:\ProgramData\HP\HP 

SoftPaq Download Manger\SWDownload” and then install each individual SoftPaq on the current 

system.   
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Using HP SoftPaq Download Manager to download SoftPaqs for multiple 

platforms 

1. Download and install HP SoftPaq Download Manager from www.hp.com/go/sdm on any 

Windows based system. 

2. Launch HP Softpack Download Manager 

3. When prompted, select Show software for all supported models (Figure A-4). 

 
Figure A-4. SoftPaq Download Manager menu  

 

 

4. Select the respective platforms in the Product Catalog window. 

5. Select the appropriate Driver and Operating System Enhancement SoftPaqs from the Available 

SoftPaqs list (Figure A-5). 

 
Figure A-5. Available SoftPaqs list  

 

 

 

 

http://www.hp.com/go/sdm
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6. Prior to downloading the sofpaqs, set your download preferences in the Configuration Options 

window (Figure A-6) accessed from the Tools menu (Tools -> Configuration Options). 

 
Figure A-6. Download tab in Configuration Options window  

 

 

7. Additional customizations are available through the Unpack tab (Figure A-7). 
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Figure A-7. Unpack tab in Configuration Options window  

 

 

 Unpack Directory – this field allows the user to change the location where the SoftPaqs will be 

unpacked once they are downloaded. 

 Unpack Folder Options 

– Legacy Behavior – this option will unpack all selected SoftPaqs in the Download Directory 

established on the Download tab (above). Unpack directory field will be locked. 

– Separate by SoftPaq IDs – this option will unpack all selected SoftPaqs in the folder designated in 

the Unpack directory. Individual SoftPaqs will be unpacked in a unique folder based on SP# (i.e. 

\SPxxxxx) according to SoftPaq category (Driver – Video, Driver – Audio, etc.). Figure A-8 shows 

an example of this folder structure. 
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Figure A-8. Example of folder structure separated by SoftPaq IDs 

 

 

– Separate by SoftPaq Names – this option will unpack all selected SoftPaqs in the folder designated 

in the Unpack directory.  Individual SoftPaqs will be unpacked in a unique folder based on SP 

Name (i.e. HP Universal Camera Driver) according to SoftPaq category (Driver – Video, Driver – 

Audio, etc.). Figure A-9 shows an example of this folder structure. 

 
Figure A-9. Example of folder structure separated by SoftPaq Name 

 

 

8. After selecting the desired SoftPaqs, the following options are available in the Downloaded SoftPaqs 

window: Download Only or Download and Unpack (Figure A-10). 
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Figure A-10. Downloaded SoftPaqs window  

 

 

 Download Only – this option will download all selected SoftPaqs according to the settings established 

in the Download tab in the Configuration Options dialog.  Default is Single Folder set to 

“C:\SoftPaqDownloadDirectory”. 

 Download and Unpack – this option will download all selected SoftPaqs according to the settings 

established in the Unpack tab in the Configuration Options dialog.  Default is Legacy Behavior 

(unpack in Download directory) “C:\SoftPaqDownloadDirectory”.   

9. After download is complete, the SoftPaqs can either be installed directly or imported into your 

respective management solution. 

For more technical information about using HP SoftPaq Download Manager, please refer to the User 

Guide at www.hp.com/go/sdm. 

http://www.hp.com/go/sdm
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Appendix B: Sample Sysprep.inf files 

Example of Windows XP SYSPREP.INF 
 

[Unattended] 

OemSkipEula=No 

OemPnPDriversPath = 

"Drv\Video;Drv\Nic;Drv\Audio;Drv\Modem;Drv\Misc1;Drv\Misc2;Drv\Misc3;Drv\Misc4;Drv\Misc5;Drv\

Chipset;Drv\KBD;Drv\MSD;Drv\USB;Drv\Network" 

 

InstallFilesPath = "C:\i386" 

 

[GuiRunOnce] 

Command0=c:\Drv\install.bat 

 

[GuiUnattended] 

AdminPassword=* 

EncryptedAdminPassword=NO 

AutoLogon=Yes 

AutoLogonAccountCreation=NO 

AutoLogonCount=1 

OEMSkipRegional=0 

OemSkipWelcome=0 

WaitForReboot=NO 

 

[UserData] 

ComputerName=* 

  

[RegionalSettings] 

LanguageGroup=1 

 

[Identification] 

JoinWorkgroup=WORKGROUP 

 

[Networking] 

InstallDefaultComponents=Yes 

 

[OEM_Ads] 

Background=BACKGRND.BMP 

 

[Data] 

UseBIOSToBoot=1 

 

[SysprepMassStorage] 

PCI\VEN_8086&DEV_2410  = %systemroot%\inf\machine.inf ;INTEL PCI-ISA bridge 

PCI\VEN_1106&DEV_0571 = %systemroot%\inf\mshdc.inf   ;VIA IDE controller 

PCI\VEN_10DE&DEV_01BC = %systemroot%\inf\mshdc.inf   ;NVidia IDE controller 
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Example of Vista / Windows 7 SYSPREP.XML 

<?xml version="1.0" encoding="utf-8"?> 

<unattend xmlns="urn:schemas-microsoft-com:unattend"> 

    <settings pass="oobeSystem"> 

        <component name="Microsoft-Windows-International-Core" processorArchitecture="x86" 

publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <InputLocale>en-us</InputLocale> 

            <SystemLocale>en-us</SystemLocale> 

            <UILanguage>en-us</UILanguage> 

            <UILanguageFallback>en-us</UILanguageFallback> 

            <UserLocale>en-us</UserLocale> 

        </component> 

        <component name="Microsoft-Windows-Shell-Setup" processorArchitecture="x86" publicKeyToken="31bf3856ad364e35" 

language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <OOBE> 

                <HideEULAPage>true</HideEULAPage> 

                <NetworkLocation>Work</NetworkLocation> 

                <ProtectYourPC>1</ProtectYourPC> 

                <SkipUserOOBE>true</SkipUserOOBE> 

            </OOBE> 

            <RegisteredOrganization>Bmankind</RegisteredOrganization> 

            <RegisteredOwner>Bmankind</RegisteredOwner> 

            <UserAccounts> 

                <LocalAccounts> 

                    <LocalAccount wcm:action="add"> 

                        <Password> 

                            <Value>cABhAHMAcwB3AG8AcgBkAFAAYQBzAHMAdwBvAHIAZAA=</Value> 

                            <PlainText>false</PlainText> 

                        </Password> 

                        <Name>UserA</Name> 

                        <Group>administrators</Group> 

                        <DisplayName>UserA</DisplayName> 

                    </LocalAccount> 

                </LocalAccounts> 

                <AdministratorPassword> 

                    

<Value>cABhAHMAcwB3AG8AcgBkAEEAZABtAGkAbgBpAHMAdAByAGEAdABvAHIAUABhAHMAcwB3AG8AcgBkAA==</V

alue> 

                    <PlainText>false</PlainText> 

                </AdministratorPassword> 

            </UserAccounts> 

        </component> 

    </settings> 

    <settings pass="auditSystem"> 

        <component name="Microsoft-Windows-PnpCustomizationsNonWinPE" processorArchitecture="x86" 

publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <DriverPaths> 

                <PathAndCredentials wcm:keyValue="dfbbff91" wcm:action="add"> 

                    <Path>C:\Drv</Path> 

                </PathAndCredentials> 

            </DriverPaths> 

        </component> 

        <component name="Microsoft-Windows-Deployment" processorArchitecture="x86" 

publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"  
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xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <Reseal> 

                <Mode>Audit</Mode> 

            </Reseal> 

            <AuditComputerName> 

                <MustReboot>false</MustReboot> 

                <Name>*</Name> 

            </AuditComputerName> 

        </component> 

        <component name="Microsoft-Windows-Shell-Setup" processorArchitecture="x86" publicKeyToken="31bf3856ad364e35" 

language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <AutoLogon> 

                <Username>Administrator</Username> 

                <Enabled>true</Enabled> 

                <LogonCount>3</LogonCount> 

            </AutoLogon> 

        </component> 

    </settings> 

    <settings pass="specialize"> 

        <component name="Microsoft-Windows-Shell-Setup" processorArchitecture="x86" publicKeyToken="31bf3856ad364e35" 

language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <ProductKey>xxxxx-xxxxx-xxxxx-xxxxx-xxxxx</ProductKey> 

            <ShowWindowsLive>false</ShowWindowsLive> 

            <TimeZone>Eastern Standard Time</TimeZone> 

            <Display> 

                <ColorDepth>32</ColorDepth> 

                <DPI>106</DPI> 

                <HorizontalResolution>1280</HorizontalResolution> 

                <RefreshRate>75</RefreshRate> 

                <VerticalResolution>1024</VerticalResolution> 

            </Display> 

            <ComputerName>*</ComputerName> 

            <CopyProfile>true</CopyProfile> 

        </component> 

        <component name="Microsoft-Windows-Security-Licensing-SLC-UX" processorArchitecture="x86" 

publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <SkipAutoActivation>true</SkipAutoActivation> 

        </component> 

        <component name="Microsoft-Windows-UnattendedJoin" processorArchitecture="x86" 

publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"  

 

xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <Identification> 

                <Credentials> 

                    <Domain>arbor01</Domain> 

                    <Password>nopass</Password> 

                    <Username>installman</Username> 

                </Credentials> 

                <JoinDomain>arbor01</JoinDomain> 

            </Identification> 

        </component> 

        <component name="Microsoft-Windows-Deployment" processorArchitecture="x86" 

publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS"  
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xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance"> 

            <RunSynchronous> 

                <RunSynchronousCommand wcm:action="add"> 

                    <Order>1</Order> 

                    <Path>net user administrator /active:yes</Path> 

                </RunSynchronousCommand> 

            </RunSynchronous> 

        </component> 

    </settings> 

    <cpi:offlineImage cpi:source="wim:d:/sources/install.wim#Windows 7 ULTIMATE" xmlns:cpi="urn:schemas-microsoft-

com:cpi" /> 

</unattend> 
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To learn more about HP business notebooks, contact your local HP sales representative or visit 
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